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* Introduction and terminology.
* Getacquainted withthe user interface

* Import data and annotations

= Identify discriminating variables using basic statistical tests
= Usevisualizationto enhance analysis and interpret results
* Presentation of data in different plot types

* Export of variable lists and images

= Biological interpretation of results
= Data Exploration - find structure inlarge data sets
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Background

QLLUCORE  customers in 25 countries
O Eee——
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References and Front Covers
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Qlucore Omics Explorer

A very fast and easy to use tool to analyze and explore data without being
a statistical expert

QLUCORE

Data types

Examples _ Supported File formats

= Gene Expression Data (array and NGS) « Affymetrix GeneChip

= DNA Methylation compatible (.cel and .chp files)
= Proteomics = Agilent txt files

= Metabolomics = BAM files (aligned for RNA-seq)
= Protein array data * GEO soft files

= miRNA data = Wizard (*.txt, *.csv)

» gPCRdata

* Flow cytometry data

= Multiplex

Any multivariate data

Course material - Basic training. © Qlucore 2016
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Terminology

|
Samp e Sample
annotation i
header annotation
Variable ArrayID 5301 5302 5303 5304
annotation Aee 3a 22 47 la1
header
Sex Female Mde Male Female
arlD ymbol Data
Variable
annotation 3140 MR1
622 |BDH1
(7551 ZNF3
1537 cyc1
1961 [cD4a7
QLUCORE
Course material - Basic training. © Qlucore 2016

Visualize and Explore
= Check quality
= ldentify structures in the data

“ Generate new hypotheses

Statistical Analysis

= Open APl to R

Statistics. )
Input: Al acte variables 50/50 vars

Filter by Variance (0/0=s)

o IEEQ
Fiterby Wit Goup Comparsen + | <
o = GO Browser

Eimnated factors (=) (&)

. t-test, ANOVA, Regression analysis.

= Easy generation and export of documentation and plots

Achieve Biological Insight
* Explore annotations

o * GSEA —Gene Set Enrichment Analysis
P r— ER]
—— o Classify and Predict
== = Build classifiers
= kNN, SVM, RT
= Use classifiers for prediction

Course material - Basic training. © Qlucore 2016
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Statistical tests

* t-test (two group comparison)
find variables that are statistically different between 2 groups.
* F-test (ANOVA - Multigroup comparison)
find variables that are statistically different between 2 or
more groups.
= Regression Analysis
(used for numerical annotations e.g. time, dose, age etc)
find variables that increase or decrease over time, dose etc.

* Open APl to R
(Welch, Limma, Mann Whitney - included)

OLUCORE
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Exercises

Import data with Wizard

ANOVA (F-test) — Export Variable list
t-test —Heatmap

Box plot

Linear Regression

Rank Regression

Bar Plot

Compare lists — Set operations

O 0 N U E W

. GEO data — additional data set for cross comparison
10. Exploratory Data Analysis — Exploration

11. Clustering

12. Import data and add annotations

Course material — Basic fraining. © Qlucore 2016
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Exercise 1 — Import data with the Wizard

1. Select File/Open Wizard

2. Select the file Import
example.txt

Select Wizard
Step through the Wizard

5. The dataset is loaded and a
Sample PCA plot is displayed

2\ Import example.txt 1.1 [fole =

2 (10 %)

* 'L
o © a0 ® j(aa)

OLUCORE
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Exercise 2 - ANOVA

= Perform ANOVA - F-test (Multigroup
comparison)

* Heat map
» Color samples according to annotations
* Find discriminating variables

= Save list, Export list

§ 8 8 8§ 8 8 ¢ B 8 8 B &

QLUCORE
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T

echniques 2

Method | Options | View i J view [clster | puid Clssif Samples | Variables | Log
e o d“m s -
- m >
OPcA O Satter O Line © Hst. m Variable Lists 3 @
© Table © Box [cstemg ]
oQ(av
Order hierarchical clustering O Search 0 o
Select heat map Qlucore Test Data Set... 50 50
Statistics @
: Input: All active variables 50/50 vars
|| Filter by Variance (o/gms
Samples | Variables | Log L —>5 g Q@
| Samples 8 x variable I0s X ) (’I Q
Annotations | ] %) XE Fiter by Multi Group Comparison v VariablelD Symbol
Treatment - Treatment 1 D01 ENC1 o
2 D02 CDK8
vaives [ X[ W[4 1 Al[O ™ 3 00 PEXT
€QY u 4 D04 VPS1ID i
O Placebo 444 bl « m )
O Drug1 444 Fas20
Drug 2 414 .
B0 Fiter by Fold Change Copy the list
O 9
Add more info to the list
Color samples } )
ANOVA (Multi group comparison) .
) p-value slider Save the list
Course material - Basic training. © Qlucore 2016

St

eps 2

Load the Qlucore Test Data set from Help/Example © Heat
Select Heat Map in the Method tab —a
Select the View Tab and changethe y-axislabelto . . ¥
Symbol
4. Gotothe View Tab and change Order to Hierarchical g = —
clustering for both the samples and thevariables ot
5. Colourthesamplesaccordingto the Treatment Q@
annotation. | 2 |
6. Select Multi group comparison in the Statistics dialog. sty o comparson ~
Select the annotation Treatment. Trestment v
7. Drag the p-value slider in the Statistics dialog. Monitorf= e
the p-values and g-values of the remaining variables.
Continue on next page.....
QLUCDRE Course material — Basic fraining. © Qlucore 2016
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Steps 2 continued

2. Create a list of the variables by making a copy of the active :;]
variablelist (Qlucore Test Data set) in the Variables tab.

9. Doubleclick on thelist to renameit.

10. Add more information to thelist by clicking on the Play ®
symbol. Add a comment. o

11. Export thelist to your PC (select the save icon) (include H
annotations)

12. Open thelist and look at the content

QLUCDRE Course material — Basic training. © Qlucore 2016

Exercise 3 — t-test

Perform a t-test (Two Group comparison)
Find discriminating variables

Show the samples and variables in
synchronized plots - heat map and PCA

Create a variable list from the heat map

P — T2 1750 | 2 e o gt =

Course material — Basic fraining. © Qlucore 2016
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Techniques 3

Statistics i

I Samples Variables | Log

o

Input: All active variables

Filter by Variance (0/Tma:)

Filter by  Two Group Comparison

lSampIes & X
Annotations | 1) g
Treatment v

vales [ X[ W[ Lt A1[wy

50/50 vars

o Hl @

v = v

Treatment

iminated Factors™ = ™[]

—G

Colour the samples

v [ Placebo -

Label

Two group comparison (t-test)

Variables

Variable USE

Create new variable list

ool = 2.3238 RIzoss2is () var.
Filter by Fold Change
u 1 H Change label Hierarchical clustering

@ List
The mouse List tool

Course material - Basic training. © Qlucore 2016

Steps 3

1. Select Two Group comparison in the statistics dialogue.

2. Compare the Placebo group with both treated groups (Select
Placebo)

3. Drag the statistical slider to find discriminating variables

4. Select Window/New synchronized plot

5. Tile the Plots using CTRL+T or Cmd+T

6. Colour the new Sample PCA plot according to Treatment

7. Obseve that the same clusters can be viewed in both the
sample PCA and the heat map

8. Create New Variable list by clicking on the icon in the
variables tab.

9. Change the mouse tool to List

10. Select the down regulated genes for the placebo group
with the list tool (select the node in the heat map)

QOLUCORE

(&

Variable Lists | ]

@ List

)
3

Course material — Basic fraining. © Qlucore 2016
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Exercise 4 — Box plot

= Display discriminating variables in Box plots
= Export plots

Value of the selected variables for each group in the selected sample annotation

: :
B ! B ==
. e
e - =
Z - T -
: - .
=2 = —
, ,
Treatment Treatment
1 _— 1
: :
= L @
:. T S a
- b

Treatment Treatment

QOLUCORE
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Techniques 4

Mode Axis Data Selection 1
e s

Mode Axis Data Selection Normalization
© sample ¢ (Teament  v] O tone O Mex
et |y © Heane0, =

x12 @ Yaxs MO PCA O Scatter © Line
'O Heat © Table  © Box

. 8x (© Veriabes slected by Y Axis ool L
i O Vbl forvhinthe [ ]
00 ‘
X- axis Sample annotation: Treatment
Y axis Variables selected by Y axis tool

Course material - Basic training. © Qlucore 2016
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1. Change the Heat map to Box Plot in the Method Tab.

2. Select Treatment on the x-axis.

Mode: ‘Axis Data Selection Normalization
© sample  x [Teament__v] O tone O Me:
Varble |y © Mean=p, V=

¥ A Data
© Nore

1@ vais O P O satter © Line ¢
© Heat © Table @ Box

3. Select Variables selected by y-axis tool
on y-axis and click on the active list.

Y- ——
©) Vit for which the

4. Change the label to Symbol
View
Label
5. Export the image — File/Export/Image j” ‘ﬁ‘

6. Openthe exported file.

OLUCORE
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Exercise 5 — Linear regression

= Perform Linear regression
* Find discriminating variables
= Show the variablesin a scatter plot

Value of the selected variables for each sample in each group in the

selected sample an
1. E ®
: ® 1 o
1 :
1 . ° °
:
0
0
. 4 0
oo & o
(. & d e
a - B ~ gl ]
L] 0.
AT 0
2 B
S & L]
-0. /e L B4 = hd @
o Bt
B e
-
i @ (]
S L D DS PSP ES S S P D Pp S e S P S &
QOLUCORE o .
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Steps 5

1. Select Linear Regression in the Statisticsdialogue ... .o -
2. Select the annotation Age A L
3. Drag thestatistical slider to find discriminating variables
4.  Show thevariables in Scatter plots .
. @ Scatter
Select Scatter Plot in the Method Tab
Select the dropdown menu for the x-axis in the Axes Data Selection
in the Method tab :xi_m
Select Sample annotation Age and Numerical scale ¥ [Menualvar, 7]
Select the dropdown menu for the y-axis in the Axes Data Selection
in the Method tab
Select Variables selected by the Y-axis tool
Click on your list of variables in the variables tab or select individual
variables in the variable list
QLUCORE . -
Course material - Basic training. © Qlucore 2016

Exercise 6 — Rank regression

= Perform Rank regression
* Work with Color gradient

QLUCORE =l o —

I]m:.x 2, Qe e DSy 12 =75 [ 2 QueaeTem b gt 1 .

\
3
- \
/
g

" Lourse material— basic raining. © wiucore 2u 18
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Techniques 6

Statistics =)

Standerd | Extended | Samples | Variables | Log |
Input: All active variables 50/50 vars | samples 8 x
Fiter by Variance (o/asss) Annotations | ] 55 X @
5 Rank -
T vaes [} 180 o
. 7] CEQY

Color gradient

p= 0025 & q= 0293 & @
Itsol = 2.5373 IRI =0.62582 Q@

| samples | variables | Log

Filter by Fold Change [S 8 x
Annotations | ] ) X @

S — N

Rank regression

@ Low 22
B Medium 4/4
W High 2/2
M Very High 272

Make sure values are in the ranked order

Course material - Basic training. © Qlucore 2016

Steps 6

1. LoadtheQlucoreTest Data Set2.gedata from the
training folder. File/open.
2. Open a new synchronized plot. Make it a heat map.
Tilethe plots
3. Select the Rank annotation (Sample tab). Sort therows 1
in rank order if the are not correctly sorted.
Use the up and down arrows.
4. Create a color gradient for the Rank annotation:

= Double click the colored box next to the "very low” value
to change color to a light color

= Do the same thing on the "very high” value but select a
dark color. Pick the colors you like.

= Now click the gradient icon and follow the instructions.

Course material — Basic fraining. © Qlucore 2016
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Steps 6 — cont.

3-4 variables left.

5. Color your PCA plot and your heatmap Q@
according to the rank annotation.

6. Inthe Statistics box select Rankregression and
select the annotation Rank.

/. Drag the statistical slider until you have around

H . . p= 0005 [ q- 024 & @
2. Notice that the samples line up inthe rank nmn am @
order [
(%] © o
e © e e
o |
© © J\\ ®

Course material - Basic training. © Qlucore 2016

Exercise 7— Bar plot

Variable ID_01 grouped by 'Gender' and 'Treatment'.

&9
Female Male

= Display results in Bar plots

Average of Variable ID_01 grouped by 'Gender' and
'Treatment'.

Course material — Basic fraining. © Qlucore 2016
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Techniques 7

Method | Options | View | Cluster | Buid Classifier | Classify
Mode

e Hist. () Heat @ Sample

@ None

Select Bar plot and
define x-axes

Plot Settings

[¥] Grid
Fivaa)ds

View tab — More plot settings

20

Options tab — for average bars

Course material - Basic training. © Qlucore 2016

Steps 7

menu.

for the x-axes

Select Whiskers: Std Dev

Continue on next page....

1. Load the Qlucore Test Data Set from the Help
2. SelectBarplot and Select Gender and Treatment

3. Selectone (or several) variable(s) for the y-axis
Colour the bars according to Treatment

5. Create average bars by selecting Average from Bar =™
options — to the farright in the Options tab Whiser | DRV~

Change the y-axis label to Symbol

@ Bar

¢ B 1*  Gender -

¢ Treatment -

Average v

Course material — Basic fraining. © Qlucore 2016
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Steps 7 - continued

2. Click the More button in the View tab and Bon
open the More plot settings Window F"”““
9. Setthe size of the 2nd x-axis label to 15 -
10. Change the angle of the first x-axis label e el
[_] Component Label
[] Ratio Label
Xm:howLab:&
Label Font Size [Aute] 4 S}
Font angle 45 gl
[] Log Scale
”SshowLaheb
Label Font Size [Aute] 10 E]
Font angle ) H
[ Log Scale
[] same Y Axis Scales
o e
Label Font Size [Auta] 10 E]
Font angle ) 2]
QLUCORE Course material - Basic training. © Qlucore 2016

Exercise 8 — Set operations

= Compare lists

= Create intersection, unions, differences

samples | Variables | Log

8 X
variable Lists [ ] X E2 [ (@ [
Q@
[7] [0 Search 0 0

Qlucore Test Data Set.gedata 1 50 0
Acute Lymphoblastic Leukemia.g... 501 501

[J F-test 502 502
O t-test 501 501
[ Intersection 211 211
O piff 201 291

Course material - Basic training. © Qlucore 2016
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Techniques 8

Samples Variables Log
l Variables

aabe Lists [ X [ 2 [

oRh(@v

Set operations

Set Operations

Take the difference v

of F-test v
and t-test -

Save the result to  [Create New List] -

Course material - Basic training. © Qlucore 2016

1. Load the Leukemia dataset from the Help menu

2. Perform a Multigroup comparison on Leukemia Subtype —
use the p-value slider and filter to approx 500 variables

. .
3. Copy the listand call it ”F-test” - o
Variable Lists ] X [ [ [ [
Perform a two group comparison on Leukemia 5w s

Qlucore Test Data Setgedatal 50 0

Acute Lymphoblastic Leukemiag... 501 501
Ftest 502 502
test 501 501
a1
01 291

subtype T-ALLand filterto approx 500 variables *
Copy the listand call it “t-test”

Use the Set Operations tool and make an intersection of the
lists —rename the list ”Intersection”

7. Usethe Set Operations tool and make a difference between
F-test and t-test. Rename the list Diff.

[EEEEES]
oooo

25
27
i
z

Course material — Basic fraining. © Qlucore 2016
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Exercise 9 — GEO data set

* Import data set from Gene Expression Omnibus
(GEO)

= Use a list generated from one data set and cross
compare in a second data set.

2 trs s motiinge 1 ot ) (=R | 4 At ymphobiotic ek gedia 1 Geskemia Soiype) ===

2(6%) 2(5%)

QLUCORE

Course material - Basic training. © Qlucore 2016

Techniques 9

Statistics Variables | Log | s
Standard | Extended [Variabes — 8x £l

Input: Allactive variables 22282/22282 vars varsevists [ X 2| 0 H

Filter by Variance (0/0=s:)

Acute Lymphoblastic ... 104 104

O T

2, Qlucore Omics Bplorer 3.1 (6461)

p= 513 [ q= 103730l @ File] View Window License _Help
Jtisol = 8.0333 IRI 20.57597 Q@ ['u' z::‘ m'u’
W Openwith War-
Fiter by Foid Change W OpenBAM fies..
b Fl H smess. R
= ,
@ Downlosd [ Affymetiix Probe Set Annotations..
& Bpot | Gopataset.

Recent Data Files > E
» [ ce0 Dourions

There are two types of GEO data sets:
(DS (GEO Data Set) - curated by GEO staff
GSE (GED Seres) - ot curated by GEO staff

B prterences.
RestoreDefau Setings

Enter accession number ("GDS" or "GSE" + any number of digits)
® o e
=] [ sampls | vartles | 1og |
Variables (-3
Warming: GSE datasets do ot avays contai normalized data. ‘ . ‘
Variable Lsts [ X 5[ (9
@Ql@av

(7] Acute Lymphoblastic ... 104 104

. |} ‘GSE13425 series_ma... 104 104
OLUCDRE Course material - Bas D
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Steps 9

1. Load the Acute Lymphoblastic Leukemia.gedata data set from the Help
menu.
2. Color the data according to the annotation Leukemia Subtype.
3. Perform a t-test on Leukemia subtype, select TEL/AMLL in the statistics box. %’W —

4. Filter down to about 100 genes, dlick the active listand press “:/ to copy Yot /xij D&

the list and rename it to “result t-test”. Acute Lymphoblastic .. 104 104
oo

5. Import a data set from GEO. Search for GSE13425 (childhood ALLs). Tile the
plots using CTRL+T or CMD+T. (If no internet connection find the data set in

Variables -3
o varisble Lists [ X 5[ (@ [
the training folder). ®alav
6. Use the generated list result t-test, which separated the TEL/AML1 subtype, Reve ymphobisc . 108 108
] GSE13425 series ma... 104 104
as input in the GSE13425 data set. P | 0 T

7. Notice the change and color the GSE13425 data set according to the

“characteristics_ch1l” annotation.

OLUCORE

Course material - Basic training. © Qlucore 2016

Exercise 10 — Exploratory Data Analysis

= Use the statistical and visual support in Qlucore
Omics Explorer for exploratory analysis and
hypothesis generation.

= Find new, previously unknown structures in data.
* Quality control — detect anomalies.

= Use the powerful pattern recognizing capabilities of
the human brain.

“
(@)

Course material — Basic fraining. © Qlucore 2016
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Techniques 10

Statistics E Plot Type Mode Axis Data Selection

Input: Al active variables 22282122282 vars
| Heat Table Box

Data [QECECR Options  View

Nearest  Dir. Conn.

Tool Box
Muli ©) Move () Color List ©) Center

O Info O Mark © Scatter ©) X-Val.

kel © o © P

sols | vnabes | 1o |

Samples. & X

Filter by Fold Change Annotations

[ # New Annotatio -
e 5 JUIEREILI
€ Y

Network

Classify

Samples | aribles | Log |

lsamples B X
Annotations j E{ﬂ X G
New Annotation v

voes [ X [ W[4 14O
€«QY

Variance filtering B NewValoe Y

O New Value (2) 0/0
W NewValue (3) 0/0

(7L New Value 132/132
| 1 NewValue (2) 0/0

New Value (3) 0/0

New annotation and values

OLUCORE

Course material - Basic training. © Qlucore 2016

Deselect group

Steps 10

from the Help menu.
Look atthe data. Canyou see any patterns?

Remove variables with low variance by moving the
variance slider

Find the maximum Projection Score, 0.43.

Use networks to connect each sample to its closest
neighbor.

o

Create a new sample annotation.

6
7. Color the data set according to the new annotation.
2. Create a new annotation value.

9. Classify the found group.

10. Deselect the found group.

11. Repeat steps 5-10.
QOLUCORE

Course

1. Load the Acute Lymphoblastic Leukemia.gedata data set

Filter by Variance (0/0-=)

Dl e @

Annotations D

e
Yalues D

(@ Annotate
Multi

material — Basic fraining. © Qlucore 2016
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Exercise 11 - Clustering

= Use k-means clustering to find structures
= Use Silhouette plots to evaluate clusters

2(10%) Silhouette plot of kmeans-4 (1) clustering

1(16 %)

Course material - Basic training. © Qlucore 2016

Techniques 11

|Da\z[Me&md|q;ﬁons|v Method | Options [ View [ Custer | BuldClassifier | Clssify |
H Mode Axis Data Selection

Normalization
Number of Clusters 4 S| © Scatter_ ) Line () Hist. ©) Heat @ Sample X © None ©
@ © sox =T
X Axis Data —
Cluster Silhouette plot settings © Sihovette  kmeans4
Samples Variables Log

Samples
Annotations | ] [

QY

[ Cluster-1
B Cluster-2
[ Cluster-3
W Cluster-4

Colour the clusters

Course material — Basic fraining. © Qlucore 2016
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Steps 11

Load the Leukemia Example Clustering dataset

2. Perform variance filtering so that you keep 10% of the variables —e.g
approx 2000
Go to the Cluster tab, set no of Clusters to 3 and press Run

4. Colour the samples according to the new clustering annotation (k-means-
3)

5. Opena New synchronized plot and make it a Silhoutte plot:
Select Bar plot in method tab and for X-axis select Silhoutte and k-means
3.

6. Inspect the clusters in the silhouette plot
Use the mouse tool Mark to mark the sample with a negative Silhoutte
value

7. Repeat step 3-6 with 4 clusters. Which cluster option seems most
relevant?

QLUCDRE Course material - Basic training. © Qlucore 2016

Data Import

.txt files — open with Wizard
.gedata files — File/Open
GEO data

Affymetrix cel files

Agilent txt files

Aligned RNA-seq BAM files

Course material — Basic fraining. © Qlucore 2016
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Exercise 12a — The Wizard

Select File/Open Wizard
Select the file Import example
without annotations.txt
Select Wizard

Step through the Wizard
The dataset is loaded and a
Sample PCA plot is displayed

2 (10 %)

1(44 %)

2, File mpor wasrd

st 707

Select row head

Column/sample annotations

Cickina co 3gan to deselec .

1 2
w0, 4186

. uw  w» B w
Somple i 616725, GUIETES... SUTIS.. GUETES. GUETIS.. S1IT2S.. GIETES.. GUSTI.. GUSTES.. GUIETE.. 611675

OLUCORE

Course material - Basic training. © Qlucore 2016

Exercise 12b — Add more annotations

Sample id [Treatment | Time [Time x treatment
6116725068_A.AVG_Signal _[Control 0 |0hControl
6116725068_B.AVG_Sgnal [Control 0 |0hControl
6116725068 _C.AVG_Signal |Control 1 [1hControl
6116725068 _D.AVG Sigral |Control 1 [1hControl
6116725068 E.AVG_Signd _|Control 2 |2hControl
6116725068 F.AVG Signd _|Control 2 |2hControl
6116725068_G.AVG Signd |Control 4 [4hControl
6116725068 _H.AVG Sigral |Control 4 |4hControl
6116725068 _|.AVG_Sigral _|Control 8 |8hControl
6116725068 _J.AVG_Sgnd _|Control 8 |8hControl
6116725068_K.AVG_Signal |Control 24 |24 h Control
6116725068 _L.AVG Signal _|Control 24 |24 h Control
L]
the imported dataset.
QLUCORE

The unique sample/variable id in the first column must match the id of

Course material - Basic training. © Qlucore 2016

- View Window License Help
[7 New > M|
@ Open.. [ () TR F:IotType -
(1 Open with Wizard... 2. ©vass ||| @Fca €
@ OpenBAMfiles... © teat €
FH savess. olor Legend & X
———|
& Import v Log...
. Download »
é Export »
Sample Annotations...
Recent Data Files >
Recent Variable List Files 4
Recent Log Files Supplementary Data...
Variable List...
%% Preferences...
Restore Default Settings
I Bt

Qlucore Copyright
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Steps 12b

w N

N o u ok

Select File/Open with Wizard
Select the file Import example without annotations.txt

Check the sample annotations in the Sample tab and see that
you only have one annotation — Sampleid

Select File/Import/Sample annotations
Select the file Annotations.txt
Import all the annotations

Check the sample annotations in the Sample tab and see that
you now have all 4 annotations

OLUCORE

Course material - Basic training. © Qlucore 2016

Save dataset

Once a data set is loaded you can
save it as a gedata.file, which will
contain all the imported data
inluding annotations.

(File/Save as)

Save logpoint to save a snap shot
of your analysis at a specific e I R

Log

point in time. oo ] (oo |

Time Name

Course material — Basic fraining. © Qlucore 2016
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Import a Data Set From GEO

1.  File/Download/GEO Data Set

', Qlucore Omics Explorer 3.0 (64-bit)

Fie) View Window License Help
(3 New > [Data | Method | Op
B open.. o [ O xaus [ patrpe
] el O YA PCA O Saatter
st ) Tabe
[ OpenBAM files... Het O
H sovers.
A& mport » There are two types of GEO data sets:
° - GDS (GEO Data Sef) - urated by GEO staff
Download [ e i e T Ry (GSE (GEO Series) - not curated by GEO staff.
»
& epor GEO Data Set.. (o= =)
Recent Data Fies » = v
Recent Varible Lzt Fil »
ecent Variable Lit iles —[ I
Recent Log Files >
& preferences... Warring: GSE data sets do not aiways contain normaized data.
Restore Default Settings
® Bit

2. Enter Accession Number GSE13425 and Press OK

oo
9] cocomponent
] commcton >

3. Select Annotations to be included and Press OK g, o=

9] o cLONED

OLUCORE

Course material - Basic training. © Qlucore 2016

Import of cel files

Preparations:
= Register on Affymetrix NetAffx
= Enter you credentials in (A =S
File/Preferences/Affymetrix e | G20 | o | sivan | oy | st
Register button. oren i nerd Wlhe
Import: poibe
User name ann.holmberg @glucore.com
1. Select File Open, select your files, press QOK, || ==t woeeeens
select normalization method, press OK sorstaton i (G BoomeriAymets =
Use cached Affymetrix fle info list (NetAffx.xmi)
The data will be normalized, log transformed
and opened up as a PCA plot Ea)

2. Import annotations

see Exercise 12b. Note: The Qlucore software must

be allowed to download

information from Affymetrix- if

this is prevented by firewall

settings etc please contact your T
¢ support.
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Import of RNA-seq BAM files

Preparations

= Enter the path to the Reference Genome (gtf) in
File/Preferences

(G T s
General | Affymetrix | GEO | Graphics | SAMBAM | Proxy | Statistics

Select Gene set fie (GTF or GTRg2)

&

Import
= Select File/Open BAM files
= Select the files

= Press OK =

= The BAM files will be counted, normalized using TMM, log
transformed and the data will be opened up in a PCA plot

Step2: Import annotations — see Exercise 12b.
Note: The BAM files need to be aligned and sorted on coordinate.
The reference genome must be the same used for the alignment.
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More info — www.qlucore.com

= Qlucore Omics OLUCORE
EXpI orer HOME  COMPANY  PRODUCTS ~ CONTACT  SUPPORT  DOWNLOADS
= Tutorial
DOCUMENTATION
= Reference manual

and focus.

* Homepage

MOVIES AND INTRODUCTIONS

=== Introduction To Qlucore Omics Explorer

. HH video
= Films —

— e
* How to documents B o
. F A Q i Qlucore Omics Explorer - a very briefintrocuction Hviseo
. i ‘Working with fewer samples. HH video

* Monthly webinars - .
= Register on the ot B s
homepage R o

NotetNo.
sound,
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& LOGOUT - QLUCUST@QLUCORE.COM
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Contact/Support

= Please feel free to contact us if you have
questions.

sara.strandberg@qglucore.com

support@qlucore.com
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